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Getting Started with Alteryx 

Samples:
There are a number of Samples that come prepackaged in your Alteryx installation. 
Simply go to File > Open Sample to find fully annotated Workflows, macros, and 
apps. Their purpose is to show you real world analytical problems and how to solve 
them. Get a sense of how to use the Alteryx Interface with the paint-by-number 
training approach in the “Open Tutorials”. Then move on to the more complex 
samples that cover everything from basic data joins to Predictive Analytics! 

Community:
Check out http://community.alteryx.com to engage in the Alteryx open forum for 
all users! Here you can post questions, answer questions, and search for previously 
discussed topics. Users also have access to the Knowledgebase which contains 
articles written by the analytics and data visualization experts from the Alteryx 
staff. Also feel free to drop Ideas in our Idea Center. This is a place for you to share 
your ideas or vote on existing ideas for improvements or tweaks to Alteryx. Your 
suggestions will ultimately drive the advancements in the future versions  
of Alteryx!
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Gallery:
Check out the Analytics Gallery at http://gallery.alteryx.com. Here you can browse 
the Alteryx Public Gallery to find apps that solve business problems across a variety 
of industries. Many of these apps can also be downloaded to your machine and 
opened in your Designer! Use the gallery to learn how apps are constructed and 
how data flows through properly configured tools. You can reverse engineer apps 
you are interested in and incorporate those features into your own workflows. The 
Macro District is also available and always growing with useful macros that simplify 
reusable processes. You can download Macros from the Gallery and add them to 
future workflows.

Alteryx Blogs:
Look to blogs written by Alteryx employees to learn more about new macros and 
Alteryx concepts at Engine Works Blog (http://www.alteryx.com/blog/engine-
works) and Chaos Reigns Within (http://www.chaosreignswithin.com/). The Engine 
Works Blog features information about new macros published in the Macro District, 
details about new releases, Inspire related posts, and more. Chaos Reigns Within is 
the personal blog of a Software Developer at Alteryx and he publishes a Blog Macro 
Pack each quarter. Some of the macros are prototypes and most have not gone 
through the extensive testing process it takes to make it into the product, but you 
just might find a solution to the problem you have been struggling with and it is as 
easy as downloading a macro!

Product Training: 
Alteryx offers an abundance of training online at http://www.alteryx.com/
product-training. The Getting Started section is great for beginners and includes 
short videos, accompanying help files, and exercises to solidify the concepts. The 
On Demand videos cover a variety of topics and can be used to learn about a 
subject in general or you can watch a video pertaining to the tool or process you 
are specifically interested in exploring. The Virtual Training Sessions are WebEx’s 
designed to be interactive and offered for users at all levels of Alteryx experience. 
If you are unable to make the scheduled time for the session, you can always watch 
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a previous recording. Alteryx also offers Classroom Training at the Irvine, CA and 
Naperville, IL office locations. You will get hands-on experience with one of our 
trainers and leave with a better understanding of the product and how you can use 
it to solve your data quandaries.

Support:
There are four ways to contact Alteryx for support: email, live chat, by phone, 
and the community. Emailing clientservices@alteryx.com is good for a variety of 
questions ranging from simple to complex. You can send screenshots or attach 
workflows and provide a description of what you are trying to achieve and someone 
from Client Services will reach out to you. Live Chat is ideal for simple questions 
that can be answered quickly. If the question is more intricate than what Live Chat 
allows for, a Client Services Rep will schedule a phone call or screen sharing session. 
You can also call us at 1-888-255-1207 for basic questions and troubleshooting. The 
Community provides you with an opportunity to find the solution to your problem or 
turn to other users for their input. You can also submit a support ticket if necessary. 
Links to all of these avenues of support are available at  
http://www.alteryx.com/support. 

Kits for Tableau & Qlik 
Present the output of your Alteryx workflow in a visually appealing way by 
downloading the Visual Analytics Kits for Tableau and Qlik. The kits contain key 
analytic applications, visualizations, and tutorial information. The Tableau kit is 
available at http://alteryx.com/kit and the Qlik kit can be found at http://pages.
alteryx.com/VisualAnalyticsKitforQlik_Reg-LP.html. 
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Activate Your License Key
Before you can get started with Alteryx, you will need to activate your  
License Key.

Please activate your License Key by doing the following:

1.	 Open Alteryx, click on Tools > Activate License Key.

2.	 Enter your License Key.

3.	 Enter your email address, click on Next.
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Workflow Configuration
Canvas Layout:
Build out your workflows vertically or horizontally. To change a single workflow, click 
anywhere on your canvas, and in your Workflow – Configuration window, under 
Canvas options, select your Layout Direction as horizontal or vertical. To set either 
as the default direction, go to Tools on the menu bar, User Settings > Edit User 
Settings > Document. Here you can specify default settings: Layout direction, zoom 
levels, container colors and canvas/ grid colors.

Runtime Tab:
Set your workflow specifications here: define record limits for all inputs in that 
specific workflow to test your configurations on a smaller dataset; show all Macro 
messages to better track down errors; disable Output tools for pre-production 
testing and investigation; or disable all Browse tools for faster production runs.
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Events Tab:
Want to trigger a secondary 
workflow based on the successful 
run of an initial workflow? Or send 
email reports after successful 
workflow runs, or be alerted to 
runtime errors?  Under the Events 
tab, add an Email Event to send an 
email after a run with errors, or use 
the Run Command to run subsequent 
workflows, reference files from 
specified directories, or even move/ 
delete files from those directories.

Arrows:
Do your tool connector arrows get a little confusing? Change their route under  
Tools > User Settings > Edit User Settings > Arrows. Then your loopy connectors 
become perpendicular or straight lines. You can even make your connections 
wireless! Right-click on any tool to select wireless Incoming or Outgoing connectors. 

 

Auto Route Bezier:
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Dataset Defaults:
Instead of selecting your preferred dataset each time you bring in a new tool or 
macro, set your Dataset Defaults under Tools > User Settings > Edit User Settings > 
Dataset Defaults. Selecting the “Most Recent Vintage” option tells Alteryx to 
automatically use the latest installed version of your data, to avoid updating your 
defaults each time your Core Data Bundle is updated.

Straight:

Wireless:
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Renaming Tools
Change tool names based upon how they are being used. Renaming is useful when a 
tool is used many times throughout the course of your Workflow, but are configured 
differently. Renaming your tools is especially important when building Wizards and 
Macros where the tool will be updated with an Action and the tool to update has to 
be selected from a list that shows all the tools used in the Workflow.

Before Renaming: After Renaming:

 
Annotating Tools:
Label your tools for clarity within your workflow by adding an annotation to the tool. 
This label moves with the tool. 
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Set Record Limits for the Inputs
When developing your Workflow, there is no 
need to bring in all your data during testing. 
Use the Record Limit option in the Properties 
for the Input to bring enough records for 
testing. You can also do this under the Runtime 
tab on your Workflow – Configuration.

Thinking Inside the Box:  
Tool Containers
The Tool Container allows the user to organize tools in a Workflow; it can be 
collapsed to give your Workflow an ‘uncluttered’ look.

Before Tool Containers:

After Tool Containers:
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Tools can be placed inside the container to isolate a process. Disabling the tool 
container will make the container collapse; the tools within the container won’t be 
executed. This is especially handy when working with Analytic Apps and Macros, as 
you can update the checkbox with an Action based on the end-user’s input. 
 

Workflow Packager (.yxwz file)
Sharing your Workflow has never been easier. Package your Workflow and its 
dependencies with the Export Package option which can be found in the menu bar 
under File, this will create a .yxwz file.

Best Practices when packaging Workflows:

1.	 Before exporting the package, make all your file paths relative. Go to Edit > 
Workflow Dependencies > Click ‘All Relative,’ since all the associated files are 
saved in the same folder when imported, the Workflow will find them.
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2.	 To package a Workflow, go to File > Export Package, the name by default is the 
Workflow name; this and the folder to save it can be changed here. To Import a 
package go to File > Import Package, select where to save import it, a list of 
files included in the package are listed.

Export Workflow Package: Import Workflow Package:

3.	 If you would like to send a sample of your data, use the Record Limit option 
when exporting, this will limit all your Inputs within your Workflow.

4.	 All the Input files will be converted to .yxdb; if you don’t wish that to  
happen, deselect the file from the Local files list and add the file from  
Options > Add File. 
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Resource Optimization Settings
Alteryx is designed to use all of the resources it possibly can. In order to make 
Alteryx run as fast as possible, it tries to balance the use of as much CPU, memory, 
and disk I/O as possible.

The good news is that most of the resource utilization can be controlled. You can 
limit the amount of memory that is used on a system, user, or Workflow level. 

The Sort/Join memory setting is not a maximum memory usage setting; it’s more 
like a minimum. One part of Alteryx (sorts) that benefits from having a big chunk of 
memory will take that entire amount right from the start. It will be split between all 
the sorts in your Workflow, but other tools will still use memory outside that sort/
join block. Some of them (e.g. drive times with a long maximum time) can use a lot.

If a sorting can be done entirely in memory, it will go faster than if we have to fall 
back to temp files, so that’s why it’s good to set this higher. But if the total memory 
usage on the system pushes it into virtual memory, you’ll be swapping data to disk in 
a much less optimal way, and performance will be much worse and that’s why setting 
it too high is a bigger concern.

The Default Dedicated Sort/Join Memory Usage can be found in Alteryx at  
Tools  > System Settings.
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Best Practices
1.	 Memory Settings 

32-bit machines: 
Setting should be on the lower, conservative side. No matter how much actual 
RAM is there, it only has at maximum 1 GB available, as soon as it is set higher, 
the machine will cross over into virtual memory and be unable to recover. 
A 32-bit machine should never have a setting over 1000MB, and 512 is a 
good setting. Set it low (128 MB), especially when using Adobe products 
simultaneously with Alteryx. 

64-bit machines: 
Set this in the system settings to half your physical memory divided by the 
number of simultaneous processes you expect to run. If you have 8 GB of 
RAM and run 2 processes at a time, your Sort/Join memory should be set to 
2GB. You might set it lower if you expect to be doing a lot of memory intensive 
processes on the machine besides Alteryx

2.	 Set your Dedicated Sort/Join Memory Usage lower or higher on a per-
Workflow basis depending on the use of your computer, doing memory 
intensive non-sort work (i.e. large drive-times) then lower it, doing memory 
intensive sort-work then higher. 

3.	 Run Alteryx at a lower priority: This will ensure that the Alteryx Engine runs at 
a lower priority than all the other applications running on the same machine. By 
doing so, even the Alteryx GUI will remain responsive when you are running a 
large Workflow in the background. This is an especially good idea for a  
shared server.

4.	 Shared Servers: For a shared server, the system owner/IT person should set the 
memory to no more than (total memory-2GB)/(Number of Users). This way if 
all the users are running Workflows at the same time the system won’t go into 
virtual memory, which really slows things down.
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5.	 Web Servers: When running Alteryx on a web server, you really want to set 
the memory to the minimum possible without impacting the performance too 
much. I would recommend trying a system memory setting of 64MB and then 
increasing the memory on a per Workflow basis as needed. It is important to 
note that the user setting for memory usually has no impact since the web 
service typically runs as a separate system user. Make sure to use the  
system settings.

6.	 Background Processing: Any time you are planning to run a Workflow in the 
background while you are going to continue doing other work, it is a good idea 
to run it with less memory. 

7.	 It is also a good idea to have the temporary directory point to a separate 
physical hard drive from your boot drive. If your temp drive points to C:\temp 
and you run a Workflow that consumes 100’s of GB of Temp space  
(it happens), your system may become unstable. 

New to 9.5: Cache Data for 
Relational Databases

Cache Data: 
Designer has a new ability of caching data from relational databases through the 
Input tool. When checked, data is stored in a yxdb file on disk so that data sources 
are not hit repeatedly during workflow development. Data can only be cached when 
running a workflow in an Alteryx Designer session. The setting is ignored when the 
workflow is run in the scheduler, in the gallery, or from the command line. Messages 
will be reported in the Output Window when data is being read from a cached 
location rather than the original data source.
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Select Tool & Filter Tool: Optimize 
by Reducing Data (Fields & Rows)

Select Tool:
A best practice to optimize the performance of your 
Workflows is to remove data that won’t be needed 
for downstream processing as quickly as possible. The 
Select tool removes fields or columns from your data. 
Other tools such as Join, Join Multiple, Spatial Match, 
Find Nearest, and to a certain degree Transform tools 
and Reporting tools have some Select functionality.

Filter Tool:
Another good way to optimize Workflow performance is using the Filter tool to 
remove unnecessary data. The Filter tool queries records in your file that meet 
specified criteria and identifies these records in your data, such as Record ID=6. You 
may choose to handle records that come from the True output differently than the 
False output by connecting additional tools to the workflow on either side. This will 
allow smaller amounts of data being passed downstream.
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New to 9.5: In-Database Tools
Exciting new set of tools to 9.5 for connecting to your Oracle and SQL databases 
(more platforms to be added in subsequent releases). These tools enable the analysis 
to be done in the database, where the data resides, eliminating time & costs. Below 
the FAQ’s.

Establishing connections
Is the driver support the same for In-Database and standard Alteryx workflows?

With In-Database, driver support has been simplified in order to optimize  
for speed:

•• For 32-bit Alteryx, 32-bit drivers for SQL Server and Oracle are supported  
with In-Database.

•• For 64-bit Alteryx, 64-bit drivers for SQL Server and Oracle are supported  
with In-database.

•• 32-bit drivers are not supported for 64-bit Alteryx. 

What permissions are required to initiate an In-Database workflow using the 
Connect In-DB tool?

Read privileges are required to access the underlying database.

What permissions are required to output data to the database using the  
Write In-DB tool?

Write privileges are required to create a table in the database.

What permissions are required to stream data into an In-Database workflow using 
the Data Stream In tool?

•• Either read-only or write privileges are sufficient when using SQL Server. 

•• Write privileges to the GLOBAL TEMPSPACE directory are required when  
using Oracle. 
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What happens to the temporary tables created by the Data Stream In tool?

The temporary tables are deleted at the end of the run. If Alteryx crashes while the 
Data Stream In tool is being run, then the next time that an In-DB Workflow, all 
temp files created by Alteryx in the db in the previous three days are cleaned out.

Are the underlying ‘rules’ (e.g., database time outs) maintained during an In-DB 
process, or does Alteryx modify or circumvent those?

The underlying ‘rules’ are maintained during the process the same as with the DB 
connections via the standard Input and Output Data tools. If there is a database 
timeout or if there is a limit to the number of queries per day that the user can run, it 
will affect the user’s connection to the database. 

SQL Statement Generation

How is the SQL statement created?

A SELECT statement is triggered by the Connect In-DB tool and additional queries 
are created by downstream tools and nested within this query. The addition of one 
of the following three tools completes the query and sends it to the underlying 
database: Write In-DB, Data Stream Out, Browse In-DB. 

A user can input his or her own SQL statement in the Query box for the Connect In-
DB tool, which also gets embedded within the SELECT statement.

When is the SQL statement processed?

The SQL query for the underlying database is triggered at runtime for each Browse, 
Data Stream Out or Write Data tool. 

How is Browse Caching Enabled?

The Browse Data In-DB tool can be configured to cache the data as a .yxdb file 
when the workflow is run. 

Once the data cached, if the workflow is re-run and the database connection or 
query (including the number of records to browse) has not changed, the query will 
not be re-run. Instead, the data will be pulled from the cache. 
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An output message indicates whether or not the data was cached. Clicking the link 
will open the data results as a .yxdb file in a separate window.

What are the differences between caching in the Input Data tool and caching in an 
In-DB workflow?

Using the “Cache data” option in the Input Data tool prevents redundant data 
transfer from a database to Alteryx, which can significantly reduce the time it takes 
to run a workflow. 

Using the “Enable caching” option in the Browse Data In-DB tool prevents the 
workflow from sending redundant queries to the underlying database. The “Enable 
caching” option is on by default.

When is the In-DB cache used?

The In-DB cache is used any time a workflow is re-run without changes to upstream 
tools. Making a change to any upstream tool will trigger a new query and a new 
cache will be created. 

Does the “Browse first [100] records” option impact the amount of data processed 
by the workflow? 

No, the “Browse first [100] records” option only limits the number of records 
displayed in the Browse. Other tools in the workflow will process the number of 
records that pass through at any given point.

For more information, please see the In-Database Overview in the Alteryx Help.
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Tips & Tricks for Database 
Connections
Alteryx Input and Output tools handle three types of database connections,  
OLE DB, ODBC and Oracle Spatial. Here are few tips to follow when connecting  
to databases.

Database Connection
Database Type

1.	 OCI (Oracle Connection) is the fastest when connecting to Oracle. OleDB is 
recommended for SQL databases. Teradata Bulk Connection for Teradata. 
ODBC for Hadoop and Impala (These two ODBC drivers get installed  
with Alteryx). 
 

2.	 Teradata Bulk Connection: Increases the speed when reading and loading 
records to Teradata. Requires Teradata Tools and Utilities to be installed 
(preferably v14), at minimum: Shared ICU Libraries, ODBC Driver for Teradata, 
Teradata GSS Client, Teradata Parallel Transporter Base and Teradata Parallel 
Transporter Stream. Ideally, running Alteryx 64-bit (using 64-bit ODBC driver)

Selecting Driver

3.	 It is best to use the native client driver provided by the database company. Also 
make sure you are selecting the version that matches your database. Native 
Driver names would look like OraClient10g_home2 or SQL Server Native  
Client 10.0.
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4.	 Alteryx Hive ODBC Connector (to connect to Hadoop) and Alteryx Impala 
ODBC Connectors get installed with Alteryx.

5.	 Allow saving password for OleDB connection: When setting up an OleDB 
connection, check the Allow saving password box in the Connection tab. This 
way the session will store the password and won’t discard it once the test is 
successful, also change the Persist Security info in the All tab to True.
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Workflow Speed 
To improve Workflow Speed when:

Reading-in

6.	 In the Input tool, use the SQL 
editor/Visual Query Builder to limit 
the fields coming in. 

7.	 Do not show % Complete: When checked, Alteryx will not try to report the 
status of reading in the file, thus speeding up the read time.

8.	 For Teradata Queries, Alteryx 9.0 allow you to specify the # of amps to leverage 
from your Teradata instance to process the query.
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9.	 Select your default view. When 
connected to your database with the 
Input tool, you can select your default 
view to be either the list of Tables (if you 
have too many it could take a while to 
load), Visual Query Builder (VQB), Stored 
Procedure or SQL Editor. 
 
 

10.	 Test your Query Now you have the ability to Test your query before submitting, 
this makes sure your SQL syntax has no errors.

Outputting

11.	 Commit as you go: It is possible to commit a number of records at a time, i.e. to 
1,000 records at a time. 

12.	 Problems with connections timing out: add a Block Until Done tool (in the 
developer section of the toolbox) after your Input tool and before the Output 
tool. This also increases the overall speed of the Workflow.
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13.	 Leverage our connectors to connect to MongoDB, Amazon S3, SharePoint, 
SalesForce, Marketo and Google Analytics, these tools are in the  
Connectors Category.

14.	 A List of supported data sources can be found at http://www.alteryx.com/
technical-specifications. 

Salesforce.com Connector
The Salesforce Input tool allows you to read and query tables from 
Salesforce.com into Alteryx.

In order to configure this tool you will need your Salesforce User 
name, Password, Security Token, Remote Access Consumer Key, and 
Consumer Secret which can be obtained from your Salesforce.com Administrator. 
The Remote Access Consumer information is found in Salesforce under Remote 
Access Authentication.

1.	 Salesforce Login URL: enter your Salesforce URL, https://login.salesforce.
com/. If you have already saved a connection history, you can choose a URL 
from the dropdown. (REQUIRED Field)

2.	 User Name: enter your Salesforce user name associated with the Salesforce 
URL specified above, this is the same username you use to log-in to your 
Salesforce.com org. (REQUIRED Field)

3.	 Password: enter your password for the Salesforce user name specified above. 
This information will be encrypted. 
NOTE: Whenever you change your password in Salesforce.com, you will also need to 
change your password here. (REQUIRED Field)
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4.	 Security Token: enter your Salesforce Security Token. This information will be 
encrypted. (REQUIRED Field)

5.	 Remote Access Consumer Key: enter your Salesforce Consumer Key. 
(REQUIRED Field)

6.	 Remote Access Consumer Secret: enter your Salesforce Consumer Secret. This 
information will be encrypted. (REQUIRED Field)

7.	 Save Connection History: when checked, the selections specified above will be 
saved for future use and available via the URL dropdown. (REQUIRED Field)

Alias Repository

Alias Repository 
Creating an Alias to manage your database connections is a must-do; it will make it 
easier to access your data and to manage the connection which allows you to update 
passwords in a single location rather than having to update every Input tool. To add 
an Alias, go to Tools, Manage Alias Repository, Add a System or User type, give it a 
name and then for the connection click on the pencil on the top and either select an 
existing connection string or create one.
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Spatial Relationship: Spatial 
Matching Tips
So you have two sets of spatial objects and want to find the spatial 
relationship between them; the Spatial Match tool would do the 
job, but how could you set up your inputs into this tool for a faster 
processing (Universe and Target)? Understanding the following will 
help you:

1.	 The Spatial Match tool will put everything in the Universe (U) tab into a 
temporary YXDB with a spatial index.

2.	 Then it has to look at every Target (T) object, but it 
can quickly ignore all Universe-side objects whose 
bounding rectangles don’t intersect the bounding 
rectangle of the Target object. [A Bounding 
Rectangle is the rectangle that bounds the  
spatial object.] 

3.	 As an example, for the common case of a smaller number of larger objects (e.g. 
store trade areas) being matched against a large, wide-spread set of smaller 
objects (e.g. nationwide customer points); it’s better to put the large set of 
wide-spread small objects on the universe side.

4.	 There are many multiple methods for spatially matching two sets of spatial 
objects. A venn diagram of each of those methods can be found in the  
Spatial Match Tool’s Help Menu.

5.	 The records that come from the Match (M) tab will be Target (T) records 
whose object had a match from the Universe (U) stream. The Universe object 
and selected fields are joined to the Target Record. The records from the 
Unmatched (U) tab will be Target records whose object had no match from the 
Universe stream.

6.	 The IMPORTANT Message is: The Spatial Match can ignore most Universe 
records that won’t match the Target record without even looking at them.
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Calgary Best Practices
•• If you are loading a very large database (over 100 million records) and know the 

type of index you will need (High or Low Selectivity), manually set your index 
type. This will save time in the long run as the Calgary Loader will not have to 
automatically try to determine what type of index to create for each record.

•• If you want to use a ‘Contains’ query on your Calgary database, you will have to 
use the Load a Single Advanced Index option. This can only be performed after 
you have created your Calgary database.

•• If you are querying a large database, try to narrow down your search criteria 
based on an indexed field using the ‘Additional Query Criteria’ tab.

»» This is especially helpful when performing a Spatial Matching in Calgary 
and you know your incoming records fall within a certain city or state.

•• For further information on the Calgary tools and Calgary indexes please refer to 
the Calgary Tools Help Menu. 
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Google Analytics: Adding Custom 
Dimensions, Metrics, & Segments

•• Do you have custom dimensions, metrics, and segments that don’t show up with 
the default dimensions, metrics, and segments?

»» You can add your custom dimensions, metrics, and segments so that they 
appear in the Google Analytics tree by default by adding them to their 
appropriate XML’s.

»» The dimension, metric, and segment XML files are located here: C:\
Program Files\Alteryx\bin\RuntimeData\Macros\Supporting_Macros.

»» Updating those XML files with account-specific properties can be done 
using any text editing software.
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Adding Descriptions to Your App & 
Changing Your App Icon
Adding a description to your app can help users understand the purpose and goal of 
your app. 
 

If publishing to the Alteryx Analytics Gallery, this description will display on the app’s 
home screen. 
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Analytic App Values
When you are developing an Analytic App, you have the ability to save the values 
you have been using for testing, then call those values back through the user 
interface. This is especially helpful if you are developing an app with several inputs.

To save, click the Save icon on the left of your app UI then choose your specific file 
name (MyAppValues.yxwv).

To open, click the Open File icon, then browse to your App Values file.

Analytic Apps Best Practices
•• New Analytic App and Macro building tutorials can be found in the list  

of samples! 
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•• Dragging any Interface Tool to the canvas automatically changes your App Type 
to ‘Analytic App’.

•• You can connect a Question Tool directly to another Tool. The result is an Action 
Tool is automatically added.

•• You now have the ability to move Analytic App questions around the UI using the 
Interface Designer. 

•• The new Interface Tools are extremely helpful, but may cause a bit of clutter for 
all of the new connections you have. Make sure you are utilizing the Wireless 
Connections feature!
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Macro Connection Abbreviations
In the sample Trade Area Creation Pie Wedge Macro, we see the 
custom macro has abbreviations for each of its two inputs.      		
	

This helps the user identify where to connect their data stream and can be created 
by specifying a character in the Connector Abbreviation section of the  
Macro Input Properties. 

 

Batch Macros
•• When utilizing a batch macro specific Interface Tool, such as a Control 

Parameter, the Macro Properties will default to Batch Macro and you will not be 
able to accidentally change this. 
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•• Protip! While a Control Parameter is often used with a batch macro, it is not 
entirely necessary!

•• Specify a custom tool name to make your macro unique.

•• Specify a Category Name and search tags for Alteryx to recognize your macro in 
the Tool Palette and to make it searchable.

•• Create your own custom macro tool categories within User Settings.

»» Click Tools > User Settings > Edit User Settings.

»» Click the Macros tab.

»» Click the plus sign to add a new macro location.

»» When developing macros, it is recommended to have both Development 
and Production categories for better organization (as shown above). 
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Iterative Macros
•• Name your inputs and outputs accordingly! This will help keep you organized 

when specifying the iteration inputs and output.

•• Try to keep your data streams organized. If your loop input is on the top, keep 
your loop output on the top as well (don’t cross the streams).
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Copy & Paste for Map Tool Unique 
Value Theme Settings
When building a thematic map with many unique values it can be very tedious to 
need to type out each of the “Specific Values” manually. A simple method to help 
you populate a consolidated list of unique values is to use either the Summarize tool 
or the Unique tool on the field you intend to base your thematic map. Using the 
Summarize tool, select the field in question and choose Group By, in the Unique tool 
simply choose your thematic field in the check box list. Put a Browse tool after either 
one of your data aggregation methods, and run the Workflow. The result will be a 
simple list made up of one field containing each of the “Specific Values” for your 
Report Map Tool. Select all of the rows and hold Ctrl+C to copy the list of values 
then paste them in to the Specific Values window in the Report Map Tool. 
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Using Legend Splitter/Builder to 
Modify the Legend
The Legend Splitter and Legend Builder tools allow for additional modifications of 
the legend from the Report Map tool as long as the “Position” of the legend is 
“Separate Field”. The Legend Splitter takes the legend and breaks it down into 
several columns:

Now that the data is broken up into columns and text, you can use 
other tools to modify the data. For this example, the focus will be 
on the Text column. In this scenario, the user wants to eliminate 
the Above and Below entries because all of the data falls between 
100 and 500.

After the Legend Splitter, a Filter can be used to remove the 
Above and Below rows from the legend. Once filtered out, bring 
in the Legend Builder tool to re-create the Legend image with the 
modified data. If done correctly, the legend should appear like the 
legend to the left: 



46|Reporting

Reporting Email
Alteryx Reporting tools give you the 
ability to create detailed and well 
organized reports whenever they are 
needed. In some cases, reports may 
need to be generated and emailed 
to their intended audience once a 
week. To help speed up that process, 
Alteryx has an Email tool which will 
allow you to create a Workflow that 
upon completion will email the results 
to whomever they need to go to! 
Choose to send a single email to a 
single recipient, or a list of recipients! 

The following image shows how you can choose to select a Field in your data stream 
to populate the email address lists, subject lines, even the Body of the Email! Also, 
by using the Directory Input tool to get a list of the files necessary to send out, the 
Email tool can also include Attachments.

It is important to note, that some organization’s IT departments will not allow a  
3rd party software access to their email system without making some changes 
internally. Check with your IT administrator if you are having issues with Alteryx 
sending emails.
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New to 9.5: Workflow and  
Macro Sharing
You can now publish and share your Workflows and Macros with other Alteryx 
Gallery users. Like Alteryx Apps, Workflows can also be run in the Gallery.  Macros 
can only be downloaded and added to your own Workflows and Apps.

Workflows and Macros are uploaded the same way Alteryx Apps are. Simply open 
the Workflow in the Alteryx Desktop Designer and click File > Publish to Web.  
Select Analytics Gallery – My Private Studio as the location you would like to 
publish the app to and fill out your credentials to the Alteryx Public Gallery. If you 
need to make changes to what will be included with your Workflow or Macro, like 
including sample data, click the File tab and link or delink to these files. You can 
also include extra files, by clicking on the Options > Add File button in the top right 
corner of the window. When you are ready, click the Publish button. Once the 
Workflow or Macro has been published, you can find it in your Private Studio. 

New to 9.5: Workflow Tags 
With Workflow Tags, users can now add preset descriptions to their Alteryx Apps, 
Workflows, and Macros. Tags allows our search engine to return better search 
results and can also add your Workflow to the Public Gallery Districts.

To add a Tag on your Workflow, open the properties of the Workflow by clicking its 
title. In the center of the properties above the Rating Stars will be a Plus Sign icon. 

Click this icon to display the Tag definition dropdown list. Current Tags  
available are:

•• Cloud

•• Database

•• Spatial

•• Predictive

•• Macro

•• Workflow

•• App

•• United Kingdom

•• Salesforce

•• Macros

•• Retail

•• Real Estate

•• MSP

•• General/Cross 
Industry

•• Financial Services

•• Communications

•• Demographics
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Choose the Tag that most suits your Workflow. After the Tag has been selected, 
click the Green Check icon  next to the dropdown list. You can select multiple 
Tags for a Workflow by repeating the previous steps. If you wish to remove a Tag, 
click the  found in the Tag box. 

New to 9.5: Gallery API
The Gallery API allows users to list apps, run apps, and retrieve app results from 
applications or web pages outside of the Private Gallery. A Gallery API Key and 
Shared Secret is required to use the Gallery API. These credentials can be found 
in your Private Studio Settings. The Private Studio Settings page can be found by 
clicking your Name in the top right corner of the Gallery (next to your avatar) and 
then clicking the Private Studio tab in the main page.

Documentation for the Gallery API and interactive examples can be found at:

https://gallery.alteryx.com/api-docs/

Or if you have access to a Private Gallery:

http://<your site>/api-docs/
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Run Command
The Run Command Tool is a very powerful tool in the Developer  
Tool Set.  

To properly understand the tool, let’s take a look at the Properties.

It seems odd that the ‘Output’ would 
be at the top of the tool properties. 
If we look at this with a top down 
approach, we then understand that 
the first thing the tool can do is 
output data. This is because many 
external command prompt programs 
need additional data. Since Alteryx 
stores data in memory, the Run 
Command cannot access it unless it 
is a file, hence the ‘Output’ option.

After the output, we specify the actual external program to run. 

Next, we have the option to specify any command arguments, or parameters for 
this tool. If an Output is specified in the Output option, you would generally call this 
information here.

Next, we have the ability to specify the directory where we are running the  
external program.

The next two options are highly recommended. If ‘Run Minimized’ is selected, the 
actual command prompt will stay minimized at runtime. If ‘Run Silent’ is selected, you 
will never see the actual command prompt pop up.

Finally, if the external program created an additional file, you can specify this file in 
your ‘Read Results’ section. This will be output to your Alteryx data stream where 
you can continue with your processing.
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DateTime Tool and Time-based 
Calculations
If your data is already formatted as YYYY-MM-DD then Alteryx will most likely read 
that field in as a Date; however, one of the most common issues with a Date field 
is that most often the source data reads Dates as a String Field because it is not in 
the proper format. Alteryx can only do calculations with dates if the field is a true 
Date/Time Field. One of the most common mistakes is taking that string field in to 
a Select Tool and changing the field type to Date. Unfortunately, that method has 
the same effect as calling an apple an orange. Most likely the date is not formatted 
in the proper way, and when converted to a Date in the Select tool, the results will 
be all null values. String based Date fields require a special conversion tool called the 
DateTime Tool. This tool has the capability to convert a string into a Date/Time field 
based on the format of the date in the data. The tool can also re-convert the data 
back to string accordingly.

For example, with dates formatted as MM-DD-YYYY in the data and a need to 
convert that date into something we can calculate with, use the DateTime Tool as 
seen below, and make sure that “Convert From String Field to Date/Time Field” is 
selected. Then find the Format of your date string in the table below. Here you are 
telling Alteryx what to look for and how to convert it. This tool can also be used to 
convert a properly formatted Date/Time field back into a string.
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Sample Tool
The Sample tool is one of those overlooked tools, very helpful 
when selecting a specified portion of the records in the  
data stream.  

One of its powerful options is the Grouping Fields which allows you to do the 
Sample selection within a specific group of records.
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Keyboard Shortcuts
•• Opening files: Did you know that you can drag files from Windows Explorer 

directly onto your canvas? Workflow files (*.yxmd, *.yxwz, *.yxmc) will open 
directly in a new tab on the workflow canvas. Data files will be represented by a 
configured Input tool for each data file on the active workflow.

•• Copy color values: You can copy/paste a color value without opening the  
color editor:

1.	 Click inside the color box – don’t highlight the values – click Ctrl+C

2.	 Click inside the other color box – don’t highlight the values – click Ctrl+V

•• Splash Screen: If you want the splash screen to go away while the program is 
loading, simply click on the splash screen image.

•• The usual suspects work within and between workflows: use Ctrl Z to undo, Ctrl 
Y to redo, Ctrl X to cut, Ctrl C to copy, Ctrl V to paste, and Ctrl F to find tools 
within the current workflow.

Key Stroke 		 Action
F1 			   Show the Help page for the selected tool.
F5 			   Refresh Configuration.
Ctrl + + (plus sign) 	 Align selected tools vertically.
Ctrl + - (minus sign) 	 Align selected tools horizontally.
Ctrl + Shift + B		  Add a Browse tool after the selected tool(s). 
					     If the selected tool has multiple outputs, a browse 
					     will be added for each.
Ctrl + Alt + B 		  Show Toolbar.
Ctrl + Alt + T 		  Show Tool Palette.
Ctrl + Alt + V 		  Show Overview.
Ctrl + Alt + O 		  Show Output Window.
Ctrl + Alt + P 		  Show Properties Window.
Ctrl + Alt + D 		  Show the Interface Designer
 
Double click any tool to reopen the Properties window after closing it.
Hold down the mouse wheel to pan the canvas. 
Alt + Left mouse button will pan the canvas.
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Shift + mouse wheel will scroll the canvas horizontally.
Ctrl + roll middle mouse wheel will zoom the canvas. 
Ctrl + Arrow key will nudge a tool by one pixel.

Adding A Custom Macro Folder  
to Your Tool Set
You now have the ability to add a custom macro category to your tool set. This can 
be a great help in keeping development and production macros organized.

•• Click Tools > User Settings > Edit User Settings.

•• Click the Macros tab, then the Plus (+) sign.

•• Enter a Category Name, then navigate to your search path.
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Alteryx Excel Driver (XLSX) vs. MS 
Excel Driver (XLSX)
Alteryx has built-in native read and write drivers for Microsoft Excel (.xlsx) to 
address data loss and performance issues reported with the Microsoft Excel Driver. 
Some of the features include:

•• Microsoft Access Data Engine is not required.

•• Up to 10x read performance improvement for large sheets.

By default, all Workflows with xlsx files will be switched to Microsoft Excel (.xlsx) 
starting with Alteryx 9.5. Users will still be able to use the MS Driver for Microsoft 
Excel by switching manually to Microsoft Excel Legacy (*.xlsx) in the Input tool.

Below are some of the key differences between both drivers:

ALTERYX DRIVER FOR 
MICROSOFT EXCEL

MS DRIVER FOR 
MICROSOFT EXCEL

Maximum Number 
of Columns (limit 
specified by Excel)

16,384

(1-2k recommended for 
performance)

255

Column name  
length and field 
names limits

Limited only by string size

256 recommended for 
compatibility

Column names are 
truncated to 64 characters

Exceeding  
record limits

(1,048,575 rows)
(16,384 columns)

Any remaining records/
columns will be truncated. 
No file is written

Writes out the maximum 
number of records/
columns and dumps the 
rest of the data.

Numbers Rounding: The formatting assigned 
to the cell will be ignored.

For example, if a cell 
contains the value 
1.27452 and the cell is 
formatted to show 2 
decimal places the full 
value of 1.27452 will be 
returned instead of 1.28.

Data will be returned using 
the formatting assigned to 
the cell.

For example, decimal 
points set to a number 
lower than the data 
contains will result in data 
loss such as 1.27452 being 
returned as 1.28.
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Join Me, Together We Will Rule the 
Universe—Doing Different Types of Joins
See the table below for using the Join tool to execute different types of joins.

Inner Join:  
contains records 
that joined from 
the L input to 
those records in 
the R input.

The J output 
of the Join tool 
contains the 
result of an 
Inner Join.

Left Unjoin:  
contains records 
from the L input 
that did NOT join 
to records from 
the R input.

The L output 
of the Join tool 
contains the 
result of a Left 
Unjoin.

Right Unjoin:  
contains records 
from the R input 
that did NOT join 
to records from 
the L input.

The R output 
of the Join tool 
contains the 
result of a Right 
Unjoin.

Left Outer Join: 
all records from 
the L input 
including the 
records that 
joined with the R 
input.

To do a Left 
Outer Join, 
connect the J 
and L outputs 
of the Join tool 
to the Union 
tool.

Right Outer Join:   
records from the 
R input including 
the records that 
joined with the L 
input.

To do a Right 
Outer Join, 
connect the J 
and R outputs 
of the Join tool 
to the Union 
tool.

Full Outer Join:  
all of the records 
from both L and 
R inputs.

To do a Full 
Outer Join, 
connect the 
J, L, and R 
outputs of the 
Join tool to the 
Union tool.
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Everything Is Equal
When writing expressions, “=” now works the same as “==”.

[GEOLEVEL]=”Street” 
[GEOLEVEL}==”Street”

Go With the Workflow
The Explorer Box tool can be used to display local and network 
directories with the same functionality of Windows Explorer. Simply 
type the directory path in the URL box to reveal the contents of a 
directory. The Explorer Box tool now supports the opening of a 
workflow file (*.yxmd, *.yxwz, *.yxmc) by dragging the file onto  
the canvas.
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In/Out

Browse

Review your data at any 
point in the work flow. Date Time 

Now

Input the current date and time 
at module runtime, in a format 
of the user’s choosing. (Useful 
for adding a date-time header to 
a report.)

Directory

Input a list of file names 
and attributes from a 
specified directory. Input

Bring data into your module by 
selecting a file or connecting to 
a database (optionally,  
using a query).

Map Input

Manually draw or select 
map objects (points, 
lines, and polygons) to be 
stored in the module. Output

Output the contents of a data 
stream to a file or database.

Text Input

Manually add data which 
will be stored in the 
module. XDF Input

This tool enables access to an 
XDF format file (the format used 
by Revolution R.

XDF Output

This tool reads an Alteryx 
data stream into an XDF 
format file, the file format 
used by Revolution R.

 
Preparation

Auto Field

Automatically set the 
field type for each string 
field to the smallest 
possible size and type 
that will accommodate 
the data in each column. Date Filter

Easily filter data based on a date 
criteria using a calendar based 
interface.

Filter

Query records based on 
an expression to split 
data into two streams, 
True (records that satisfy 
the expression) and False 
(those that do not). Formula

Create or update fields using one 
or more expressions to perform 
a broad variety of calculations 
and/or operations.

Generate 
Rows

Create new rows of data. 
Useful for creating a 
sequence of numbers, 
transactions, or dates. Impute 

Values

Update specific values in a 
numeric data field with another 
selected value. Useful for 
replacing NULL() values.
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Multi-Field 
Binning 

Group multiple numeric 
fields into tiles or bins, 
especially for use in 
predictive analysis. Multi-Field 

Formula

Create or update multiple 
fields using a single expression 
to perform a broad variety of 
calculations and/or operations.

Multi-Row 
Formula

Create or update a single 
field using an expression 
that can reference 
fields in subsequent 
and/or prior rows to 
perform a broad variety 
of calculations and/or 
operations. Useful for 
parsing complex data and 
creating running totals.

 Random % 
Sample

Generate a random number or 
percentage of records passing 
through the data stream.

Record ID

Assign a unique identifier 
to each record.

Sample

Limit the data stream to a 
number, percentage, or random 
set of records.

Select

Select, deselect, reorder 
and rename fields, 
change field type or size, 
and assign a description.

Select 
Record

Select specific records and/
or ranges of records including 
discontinuous ranges. Useful for 
troubleshooting and sampling.

Sort

Sort records based on 
the values in one or  
more fields. Tile

Group data into sets (tiles) based 
on value ranges in a field.

Unique

Separate data into two 
streams, duplicate and 
unique records, based  
on the fields of the  
user's choosing.

 
Join

Append Field

Append the fields from 
a source input to every 
record of a target input. 
Each record of the target 
input will be duplicated 
for every record in the 
source input.

Business 
Listing 

Matching

Match your customer or 
prospect file to the Dun & 
Bradstreet business file.

 Consumer- 
View 

Matching

An updated version 
of the Household File 
Matching Tool with 
functionality and new 
matching criteria Find Replace

Search for data in one field from 
one data stream and replace 
it with a specified field from a 
different stream. Similar to an 
Excel VLOOKUP.
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Fuzzy Match

Identify non-identical 
duplicates in a  
data stream. Household 

File Matching

Match your customer file to 
the Experian Consumer View 
Household file.

Join

Combine two inputs 
based on a common field 
or record position. In the 
joined output, each row 
will contain the data from 
both inputs.

Join Multiple

Combine two or more inputs 
based on a common field or 
record position. In the joined 
output, each row will contain the 
data from each input

Make Group

Assemble pairs of 
matches into groups 
based on their 
relationships. Generally 
used with the Fuzzy 
Match tool.

Union

Combine two or more data 
streams with similar structures 
based on field names or 
positions. In the output, each 
column will contain the data 
from each input.

 
Parse

Date Time

Transform date/time data 
to and from a variety of 
formats, including both 
expression-friendly and 
human readable formats.

RegEx

Parse, match, or replace data 
using regular expression syntax.

Text to 
Columns

Split the text from one 
field into separate rows 
or columns.

XML Parse

Read in XML snippets and parse 
them into individual fields.

 
Transform

Arrange

Manually transpose 
and rearrange fields for 
presentation purposes. Count 

Records

Count the records passing 
through the data stream. A 
count of zero is returned if no 
records pass through.

Cross Tab

Pivot the orientation 
of the data stream so 
that vertical fields are 
on the horizontal axis, 
summarized where 
specified.

Running 
Total

Calculate a cumulative sum per 
record in a data stream.
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Summarize

Summarize data by 
grouping, summing, 
counting, spatial 
processing, string 
concatenation, and 
much more. The output 
contains only the results 
of the calculation(s).

Transpose

Pivot the orientation of the data 
stream so that horizontal fields 
are on the vertical axis.

Weighted 
Average

Calculate the weighted 
average of a set of values 
where some records are 
configured to contribute 
more than others.

 
Reporting

Charting

Create a chart (Area, 
Column, Bar, Line, Pie, 
etc.) for output via the 
Render tool. Email

Send emails for each record with 
attachments or e-mail generated 
reports if desired.

Image

Add an image for output 
via the Render tool.

Layout

Arrange two or more reporting 
snippets horizontally or 
vertically for output via the 
Render tool.

Map Legend 
Builder

Recombine the 
component parts of a 
map legend (created 
using the Map Legend 
Splitter) into a single 
legend table, after 
customization by  
other tools.

Map Legend 
Splitter

Split the legend from the Report 
Map tool into its component 
parts for customization by other 
tools. (Generally recombined by 
the Map Legend Builder.)

Overlay

Arrange reporting 
snippets on top of one 
another for output via 
the Render tool. Render

Output report snippets into 
presentation-quality reports in 
a variety of formats, including 
PDF, HTML, XLSX and DOCX.

Report 
Footer

Add a footer to a report 
for output via the  
Render tool. Report 

Header

Add a header to a report for 
output via the Render tool.

Report Map

Create a map for output 
via the Render tool.

Report Text

Add and customize text for 
output via the Render tool.
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Table

Create a data table  
for output via the  
Render tool.

 
Documentation

Comment

Add annotation or images 
to the module canvas to 
capture notes or explain 
processes for later 
reference.

 Explorer Box

Add a web page or Windows 
Explorer window to your canvas.

Tool 
Container

Organize tools into a 
single box which can be 
collapsed or disabled.

 
Spatial

Buffer

Expand or contract the 
extents of a spatial object 
(typically a polygon).  Create 

Points

Create spatial points in the  
data stream using numeric 
coordinate fields.

Distance

Calculate the distance 
or drive time between a 
point and another point, 
line, or polygon.  Find Nearest

Identify the closest points or 
polygons in one file to the points 
in a second file.

Generalize

Simplify a polygon 
or polyline object by 
decreasing the number 
of nodes. Heat Map

Generate polygons representing 
different levels of “heat” (e.g. 
demand) in a given area, based 
on individual records (e.g. 
customers)

Make Grid

Create a grid within 
spatial objects in the  
data stream.  Non Overlap 

Drivetime

Create drive time trade areas 
that do not overlap for a  
point file.

Poly-Build

Create a polygon or 
polyline from sets  
of points.  Poly-Split

Split a polygon or polyline into 
its component polygons, lines, 
or points.

Smooth

Round off sharp angles 
of a polygon or polyline 
by adding nodes along 
its lines.  Spatial Info

Extract information about a 
spatial object, such as area, 
centroid, bounding  
rectangle, etc.
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Spatial 
Match

Combine two data 
streams based on the 
relationship between two 
sets of spatial objects to 
determine if the objects 
intersect, contain or 
touch one another.

 Spatial 
Process

Create a new spatial object from 
the combination or intersection 
of two spatial objects.

Trade Area

Define radii (including 
non-overlapping) or 
drive-time polygons 
around specified points.

 
Interface

Action

Updates the 
configuration of a module 
with values provided by 
interface questions, then 
run as an app or macro.  Check Box

Display a check box option  
to the end user in an app  
or macro. 

Condition

Tests for the presence of 
user selections. The state 
is either true or false. Control 

Parameter

Control Parameter tool is the 
input for each iteration in the 
Batch Macro. 

Date

Allows users to select 
a date.

 Drop Down

Allows users to make a single 
selection from a drop down list.

Error 
Message

Display an error message 
and halt processing.

 File Browse

Allow users to select a file to 
use as an input or output via a 
traditional file browse window. 

Folder 
Browse

Allow users to browse to 
a folder via a traditional 
file browse window.

 List Box

Allow users to make multiple 
selections from a list box.

Macro Input

Create an input 
connection on a macro.  Macro 

Output

Create an output connection on 
a macro.
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Map

Display an interactive 
map to allow the user  
to draw or select 
location objects  Numeric 

Up/Down

Allow users to choose a number 
from a predefined range.

Radio Button

Allow users to select an 
option from a mutually 
exclusive list when used 
with other radio  
button tools.  Text Box

Allow users to enter characters 
in a free form text box.

Tree

Allow users to make one 
or more selections from 
an organized, hierarchical 
data structure.

 
Data Investigation

Association 
Analysis

Determine which fields 
in a database have a 
bivariate association with 
one another.

 Contingency 
Table

Create a contingency table 
based on selected fields, to list 
all combinations of the field 
values with frequency and 
percent columns.

Create 
Samples

Split the data stream into 
two or three random 
samples with a specified 
percentage of records 
in the estimation and 
validation samples.

 Distributed 
Analysis

Allows you to fit one or more 
distributions to the input data 
and compare them based on 
a number of Goodness-of-Fit 
statistics. 

Field 
Summary

Produce a concise 
summary report of 
descriptive statistics for 
the selected data fields.

 Frequency 
Table

Produce a frequency analysis for 
selected fields - output includes 
a summary of the selected 
field(s) with frequency counts 
and percentages for each value 
in a field.

Heat Plot

This tools plots the 
empirical bivariate 
density of two numeric 
fields using colors to 
indicate variations in the 
density of the data for 
different levels of the 
two fields

 Histogram

Provides a histogram plot for 
a numeric field. Optionally, it 
provides a smoothed empirical 
density plot. Frequencies are 
displayed when a density plot is 
not selected, and probabilities 
when this option is selected.

Oversample 
Field

Sample incoming data 
so that there is equal 
representation of data 
values to enable effective 
use in a predictive model.

 Pearson 
Correlation

Correlation (often measured 
as a correlation coefficient, 
p), indicates the strength and 
direction of a linear relationship 
between two or more random 
variables. 
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Plot of 
Means

Take a numeric or binary 
categorical (converted 
into a set of zero and 
one values) field as a 
response field along 
with a categorical field 
and plot the mean of the 
response field for each of 
the categories (levels) of 
the categorical field.

 Scatterplot

Produce enhanced scatterplots, 
with options to include 
boxplots in the margins, a linear 
regression line, a smooth curve 
via non-parametric regression, 
a smoothed conditional spread, 
outlier identification, and a 
regression line. 

Spearman 
Correlation

Assesses how well an 
arbitrary monotonic 
function could describe 
the relationship between 
two variables without 
making any other 
assumptions about the 
particular nature of the 
relationship between the 
variables.

 Violin Plot

Shows the distribution of a 
single numeric variable, and 
conveys the density of the 
distribution based on a kernel 
smoother that indicates the 
density of values (via width) of 
the numeric field.

 
Predictive

AB Analysis

Compare the percentage 
change in a performance 
measure to the same 
measure one year prior.  AB Controls

Match one to ten control units 
(e.g., stores, customers, etc.) 
to each member of a set of 
previously selected test units 
on the criteria such as seasonal 
patterns and growth trends for a 
key performance indicator, along 
with other user provided criteria. 

AB 
Treatments

Determine which  
group is the best fit for 
AB testing.

 AB Trend

Create measures of trend and 
seasonal patterns that can 
be used in helping to match 
treatment to control units (e.g., 
stores or customers) for A/B 
testing. The trend measure 
is based on period to period 
percentage changes in the 
rolling average (taken over a one 
year period) in a performance 
measure of interest. The same 
measure is used to assess 
seasonal effects. In particular, 
the percentage of the total level 
of the measure in each reporting 
period is used to assess  
seasonal patterns.
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Boosted 
Model

Create generalized 
boosted regression 
models based on the 
gradient boosting 
methods of Friedman.* 
It works by serially 
adding simple decision 
tree models to a model 
ensemble so as to 
minimize an appropriate 
loss function.

 Count 
Regression

Estimate regression models for 
count data (e.g., the number of 
store visits a customer makes in 
a year), using Poisson regression, 
quasi-Poisson regression, or 
negative binomial regression. 

Decision 
Tree

Predict a target variable 
using one or more 
predictor variables that 
are expected to have an 
influence on the target 
variable by constructing 
a set of if-then split rules 
that optimize a criteria.

 Forest 
Model

Predict a target variable using 
one or more predictor variables 
that are expected to have an 
influence on the target variable, 
by constructing and combining 
a set of decision tree models 
(an “ensemble” of decision tree 
models).

Gamma 
Regression

Relate a Gamma 
distributed, strictly 
positive variable of 
interest (target variable) 
to one or more variables 
(predictor variables) that 
are expected to have an 
influence on the target 
variable.

 Lift Chart

Compare the improvement 
(or lift) that various models 
provide to each other as well 
as a ‘random guess’ to help 
determine which model is ‘best.’ 
Produce a cumulative captured 
response chart (also called a 
gains chart) or an incremental 
response rate chart.

Linear 
Regression

Relate a variable of 
interest (target variable) 
to one or more variables 
(predictor variables) that 
are expected to have an 
influence on the target 
variable. (Also known as 
a linear model or a least-
squares regression.)

 Logistic 
Regression

Relate a binary (yes/no) variable 
of interest (target variable) to 
one or more variables (predictor 
variables) that are expected to 
have an influence on the target 
variable.

Market 
Basket 
Inspect

Step 2 of a Market Basket 
Analysis: Take the output 
of the MB Rules tool, 
and provide a listing and 
analysis of those rules 
that can be filtered on 
several criteria in order 
to reduce the number or 
returned rules or item 
sets to a manageable 
number.

 Market 
Basket Rules

Step 1 of a Market Basket 
Analysis: Take transaction 
oriented data and create either 
a set of association rules or 
frequent item sets. A summary 
report of both the transaction 
data and the rules/item sets is 
produced, along with a model 
object that can be further 
investigated in an MB Inspect 
tool.
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Naives Bayes

Creates a binomial or 
multinomial probabilistic 
classification model 
of the relationship 
between a set of 
predictor variables and 
a categorical target 
variable.  

 Nested Test

Examine whether two models, 
one of which contains a subset 
of the variables contained in the 
other, are statistically equivalent 
in terms of their predictive 
capability.

Neural 
Networks

Create feedforward 
perceptron neural 
network model with a 
single hidden layer.  Score

Calculate a predicted value for 
the target variable in the model. 

Spline Model

Predict a variable of 
interest (target variable) 
based on one or more 
predictor variables using 
the two-step approach of 
Friedman’s multivariate 
adaptive regression 
(MARS) algorithm. 

 Stepwise

Determine the “best” predictor 
variables to include in a model 
out of a larger set of potential 
predictor variables for linear, 
logistic, and other traditional 
regression models.

Support 
Vector 

Machine

Support Vector Machines 
(SVM), or Support 
Vector Networks (SVN), 
are popular supervised 
learning algorithms 
used for classification 
problems, and are 
meant to accommodate 
instances where the data 
(i.e., observations) are 
considered linearly  
non-separable. 

 Test of 
Means

Compare the difference in 
the mean values for a numeric 
response field between a 
control group and one or more 
treatment groups

 
Time Series

TS ARIMA

Estimate a univariate  
time series forecasting 
model using an 
autoregressive integrated 
moving average (or 
ARIMA) method.

 TS Compare

Compare one or more univariate 
time series models created with 
either the ETS or ARIMA tools.

TS Covariant 
Forecast

Provide forecasts from an 
ARIMA model that uses 
covariates. The number 
of periods to forecast 
is determined by the 
number of periods of 
covariate data provided.

 TS ETS

Estimate a univariate time series 
forecasting model using an 
exponential smoothing method.
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TS Filler

This tool allows a user 
to take a data stream of 
time series data and “fill 
in” any gaps in the series  TS Forecast

Provide forecasts from either 
an ARIMA or ETS model for 
a specific number of future 
periods.

TS Plot

Create a number of 
different univariate time 
series plots, to aid in the 
understanding the time 
series data and determine 
how to develop a 
forecasting model.

 
Predictive Grouping

Append 
Cluster

Appends the cluster 
assignments from a 
K-Centroids Cluster 
Analysis tool to a data 
stream containing the 
set of fields (with the 
same names, but not 
necessarily the same 
values) used to create the 
original cluster solution.

 Find Nearest 
Neighbor

Find the selected number of 
nearest neighbors in the “data” 
stream that corresponds to 
each record in the “query” 
stream based on their Euclidean 
distance.

K-Centroids 
Analysis

Partition records into “K 
groups” around centroids 
by assigning cluster 
memberships, using 
K-Means, K-Medians, or 
Neural Gas clustering.

 K-Centroids 
Diagnostics

Assess the appropriate number 
of clusters to specify, given the 
data and the selected Predictive 
Grouping algorithm (K-Means, 
K-Medians, or Neural Gas).

Principal 
Components

Reduce the dimensions 
(number of numeric 
fields) in a database by 
transforming the original 
set of fields into a smaller 
set that accounts for 
most of the variance (i.e., 
information) in the data. 
The new fields are called 
factors, or principal 
components.

 
Connectors

Amazon S3 
Download

Read CSV, DBF and 
YXDB files from  
Amazon S3.  Amazon S3 

Upload

Write CSV, DBF and YXDB files 
to Amazon S3.
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Download

Retrieve data from a 
specified URL, including 
an FTP site, for use in a 
data stream.

Google 
Analytics

Bring in data from Google 
Analytics

HDFS Input

Reads data from a 
Hadoop Distributed File 
System.  HDFS 

Output

Writes data to a Hadoop 
Distributed File System.

Marketo 
Append

Retrieves Lead and 
Activity records from 
Marketo and appends 
them to an incoming 
datastream

 Marketo 
Input

Read Lead and Change  
Marketo records for a specified 
date range

Marketo 
Output

Writes data to Marketo 
using an upsert function.  MongoDB 

Input

Read and query data from a 
MongoDB database. MongoDB 
is a scalable, high-performance, 
open source NoSQL database.

MongoDB 
Output

Write data to a MongoDB 
database. MongoDB 
is a scalable, high-
performance, open 
source NoSQL database.

 Salesforce 
Input

Read and query data from 
Salesforce.com.

Salesforce 
Output

Write data to  
Salesforce.com.  SharePoint 

List Input

Read a list from SharePoint.

SharePoint 
List Output

Write data to a list in 
SharePoint.

 
Address

 Canada 
Geocoder

Determine the 
coordinates (Latitude 
and Longitude) of an 
address and attach a 
corresponding spatial 
object to your data 
stream. Uses multiple 
tools to produce the most 
accurate answer.

 CASS

Standardize address data to 
conform to the U.S. Postal 
Service CASS (Coding Accuracy 
Support System) or Canadian 
SOA (Statement of Accuracy).
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Parse 
Address

Parse a single address 
field into different fields 
for each component part 
such as: number, street, 
city, ZIP. Consider using 
the CASS tool for better 
accuracy.

 Street 
Geocoder

Determine the coordinates 
(Latitude and Longitude) 
of an address and attach a 
corresponding spatial object to 
your data stream. Consider using 
the U.S. Geocoder or Canadian 
Geocoder macros for better 
accuracy.

US Geocoder

Determine the 
coordinates (Latitude 
and Longitude) of an 
address and attach a 
corresponding spatial 
object to your data 
stream. Uses multiple 
tools to produce the most 
accurate answer.

 US ZIP9 
Coder

Determine the coordinates 
(Latitude and Longitude) of a 5, 
7, or 9 digit ZIP code.

 
Demographic Analysis

 Allocate 
Append

Append demographic 
variables to your data 
stream from the  
installed dataset(s).

 Allocate 
Input

Input geographies and 
demographics into a data stream 
from the installed dataset(s).

Allocate 
Metainfo

Input demographic 
descriptions and 
unabbreviated variable 
names (“popcy” is 
displayed as “population 
current year”) from the 
installed dataset(s).

 Allocate 
Report

Create pre-formatted reports 
associated with Allocate data 
from the installed dataset(s).

 
Behavior Analysis

Behavior 
Metainfo

Input behavior cluster 
names, IDs and other 
meta info from an 
installed dataset.

 Cluster 
Code

Append a behavior cluster code 
to each record in the incoming 
stream.

 Compare 
Behavior

Compare two behavior 
profile sets to output a 
variety of measures such 
as market potential index, 
penetration, etc.

 Create 
Profile

Create behavior profiles from 
cluster information in an 
incoming data stream.

 Detail Fields

Split a behavior profile 
set into its individual 
clusters and details.

 Profile Input

Input a behavior profile set from 
an installed dataset or external 
file.
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 Profile 
Output

Output a profile set (*.scd 
file) from behavior profile 
sets in an incoming data 
stream. Generally only 
used when using the 
standalone Solocast 
desktop tool.

 Report: 

Generate a comparison report 
from two behavior profile sets 
for output via the Render tool.

 Report: 
Detail

Generate a detailed 
report from a behavior 
profile set for output via 
the Render tool.  Report: 

Rank

Generate a rank report from 
a set of behavior profiles for 
output via the Render tool.

 
Calgary

Calgary Input

Input data from the 
Calgary database file 
with a query  Calgary Join

Query a Calgary database 
dynamically based on values 
from an incoming data stream.

 Calgary 
Loader

Create a highly indexed 
and compressed Calgary 
database which allows for 
extremely fast queries.  Cross Count

Find the counts of predefined 
sets of values that occur in a 
Calgary database file.

 Cross Count 
Append

Find the counts of sets of 
values (from the incoming 
data stream) that occur in 
a Calgary database file.

 
Developer

API Output

Return the results of a 
data stream directly to 
an API callback function. 
For use with custom 
application development.

 Base64 
Encoder

The Base 64 Encoder macro 
issues a base 64 encode string

 BlobConvert

The Blob Convert tool 
will take different data 
types and either converts 
them to a Binary Large 
Object (Blob) or takes a 
Blob and converts it to a 
different data type.

 BlobInput

The Blob input tool will read a 
Binary Large Object such as an 
image or media file, by browsing 
directly to a file or passing a list 
of files to read.
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BlobOutput

The Blob Output tool 
writes out each record 
into its own file  Block Until 

Done

Stop downstream processing 
until the very last record has 
arrived, to ensure that only a 
single output stream processes 
records at one time. Or, ensure 
that the reading of a file will 
be closed before overwriting is 
attempted.

 Detour

Bypass a set of tools. 
Must end in an Output 
or Detour End tool. 
Generally used for 
authoring an Analytic 
App or Macro.

 Detour End

Ends a section of tools bypassed 
by a Detour. Generally used for 
authoring an Analytic App or 
Macro.

Dynamic 
Input

Read from input files or 
databases at runtime 
using an incoming data 
stream to dynamically 
choose the data. 
Allows for dynamically 
generated queries.

 Dynamic 
Rename

Dynamically (using data from an 
incoming stream) rename fields. 
Useful when applying custom 
parsing to text files.

 Dynamic 
Replace

Replace data values 
in a series of fields 
(using a dynamically 
specified condition) with 
expressions or values 
from an incoming stream.

 Dynamic 
Select

Select or de-select fields by field 
type or an expression.

Field Info

Output the schema (field 
types and names, etc.) of 
a data stream.  JSON Parse

The JSON Parse tool separates 
Java Script Object Notation 
text into a table schema for 
the purpose of downstream 
processing. 

 Message

Write log messages to 
the Output Window. 
Generally used in 
authoring macros.  R

Execute an R language script 
and link incoming and outgoing 
data from Alteryx to R, an open-
source tool used for statistical 
and predictive analysis.

 Run 
Command

Run external  
programs as part of an 
Alteryx process

 Test

Test assumptions in a data 
stream.
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Social Media

DataSift

Bring in data from 
Datasift- twitter, 
Facebook, Tumblr, 
YouTube, Wikipedia, 
and much more- http://
datasift.com/platform/
datasources/

 Foursquare

Search Foursquare Venues by 
a location with an option of 
filtering by a search term..

 GNIP Input

Bring in data collected 
from twitter, YouTube, 
Facebook in Grip and 
analyze it in Alteryx

 Twitter 
Search

Search tweets of the last 7 
days by given search terms with 
location and user relationship as 
optional properties.

 
Laboratory

JSON Build

The JSON Build tool 
takes the table schema 
of the JSON Parse tool 
and builds it back into 
properly formatted Java 
Script Object Notation.

 Make 
Columns

The Make Columns tool takes 
rows of data and arranges 
them by wrapping records into 
multiple columns. The user can 
specify how many columns to 
create and whether they want 
records to layout horizontally or 
vertically.

 Throttle

The Throttle tool slows 
down the speed of the 
downstream tool by 
limiting the number of 
records that are passed 
through the Throttle tool.

 
In-Database Tools

Browse Data 
In-DB

Review your data at 
any point in an In-DB 
workflow. Note: Each 
In-DB Browse triggers a 
database query and can 
impact performance.

 Connect 
In-DB

Establish a database connection 
for an In-DB workflow

 Data  
Stream In

Bring data from a 
standard workflow into 
an In-DB workflow.  Data Stream 

Out

Stream data from an In-
DB workflow to a standard 
workflow, with an option to sort 
the records.

 Filter In-DB

Filter In-DB records with 
a Basic filter or with a 
Custom expression using 
the database’s native 
language (e.g., SQL).

 Formula 
In-DB

Create or update fields in an 
In-DB data stream with an 
expression using the database’s 
native language (e.g., SQL).
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 Join In-DB

Combine two In-DB 
data streams based 
on common fields by 
performing an inner or 
outer join.

 Sample In-
DB

Limit the In-DB data stream 
to a number or percentage of 
records.

 Select In-DB

Select, deselect, reorder, 
and rename fields in an 
In-DB workflow.  Summarize 

In-DB

Summarize In-DB data by 
grouping, summing, counting, 
counting distinct fields, and 
more. The output contains only 
the result of the calculation(s).

 Union In-DB

Combine two or more 
In-DB data streams 
with similar structures 
based on field names or 
positions. In the output, 
each column will contain 
the data from each input.

 Write In-DB

Use an In-DB data stream to 
create or update a table directly 
in the database.


